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Printing with ImageBrowser

Printing with ImageBrowser

ImageBrowser enables you to import image data captured with digital cameras or scanners into a
computer and produce photo-quality printouts in a quick and easy fashion. Using ImageBrowser
with a Canon BJ printer and a scanner or digital camera, you can enjoy superb-quality photo prints.

Custom Layout Printing Index Printing
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You can quickly reorganize the selected images. The You can print a photo index that contains thumbnails
trimming and text insertion tasks are also easy. automatically arranged in a suitable layout for the

selected thumbnail size (large, medium, or small).



Fixed Photo Size Printing

You can print images in the specified photo size.

Printing with ImageBrowser

Tiled Photo Printing (Borderless Printing)

You can print images with no margins around each
image, so that a single image is printed borderless along
the paper edges and multiple images are arranged like
tiles with no space between them (available with BJ
printers that support the borderless printing feature).



Printing with ImageBrowser

Canon Perforated Paper Printing

You can easily make your images fit in a sheet of Canon
perforated paper.



Basic Operation Procedure
&

The basic operation steps to capture, import, edit, and print photo images are summarized below.

1 Acquiring images with a camera or scanner
Capture your favorite images with your digital camera or scanner.




Importing images

Start ImageBrowser. Import images stored in the memory card or
the digital camera into the Camera Window.
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ImageBrowser supports some simple
image editing features. [ | [C_ex |

The Automation wizard provides easy means of
importing images.



Selecting a layout

Select a layout you want to use and specify the type, orientation, and size of paper.
The wizard allows you to easily choose the free layout option, the image index (list) format, or the perforated paper.

Layout Options

Confirm the page setup.

Layout Options —————|

Paper size :
Vertical297.0 X Horizontal209.9mm

@ Custom layout printing

() Tiled photo printing

How would you like to print your photos?

() Fixed photo size printing

(3 Canon perforated paper printing

Prints each image at the individually
specified size and position.

[ Display this dialog when the Print window displays

Cancel

Preview

Canon $330

Ver|

Height:2794mm  Whidth :215.9mm

Min,

Paper Size: | Letter

[ Banner Printing
4 Borderless Printing

Amount of Extension :

Scale: E %

or

[ Save Settings

* The windows shown above are from BJ S330.
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4 Page Artwork

Changing the image size, trimming, and inserting of text are also easy tasks. Remember, however, you can rearrange the

images or change the image size only when you have selected the Custom layout printing option.
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Printing

B |

- ]

The images can be printed on Canon perforated paper (such as Photo Paper Pro <PR-101S> or
Glossy Photo Cards <FM-101>). Borderless printing is also supported.

* Some features and paper sizes may not be supported depending on the models of printers.
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Canon Utilities are application software included in the “BJ Solution Disk” or

“Setup & User’s Guide” in the CD-ROM, which is supplied with Canon BJ series printers. These
utilities enable you to display, save (import) to hard disk, edit, print the images captured by digital
cameras or scanners.

* ImageBrowser

ImageBrowser allows you to display a list of thumbnails (images stored in the internal memory
card), import them to your computer, and print them in photo-quality using the BJ printer. With
ImageBrowser, you can easily display, edit, and manage images stored in your computer’s hard disk
as well.

¢ PhotoStitch

PhotoStitch is an utility program for image merging and allows you to quickly create panoramic
photos by merging multiple images captured with your digital camera.

With PhotoStitch, you can merge any number of images vertically or horizontally, producing unique
posters or other photo-prints.The wide-mode merging feature is also useful when you want to create
a wide panoramic photo of a building or straight-lined object with straight lines as natural as the
original.
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ImageBrowser automatically starts through its automatic execution feature. You can also start
ImageBrowser by double-clicking its icon in the same way as you would for other applications.

ImageBrowser supports the following image file types:

Joint Photographic Experts Group (JPEG) CIFF
Tagged Image File Format (TIFF) PICT
EXIF Windows Bitmap (BMP)

Automatic execution by the Automation wizard

ImageBrowser automatically starts when it detects a digital camera connected to your computer. At
the same time, the Automation wizard starts.

The digital camera is
detected.

Note >» ThecCanon ImageBrowser Auto Launch control panel allows you to specify whether
ImageBrowser automatically starts or not when the digital camera is detected.
When this option is not selected, ImageBrowser will not automatically launch even
if the digital camera is detected.

Canon Canon Utilities
ImageBrowser

Importing Images with the Automation Wizard

Starting ImageBrowser 13



Starting ImageBrowser manually

As with other applications, ImageBrowser can be started by double-clicking its icon.

When you install ImageBrowser onto you computer, you can select the option to create the Canon
ImageBrowser icon (alias) on the desktop.

% ———— Canon ImageBrowser on the desktop

IrmageBrowser

Double-clicking the Canon ImageBrowser icon (alias) on the desktop will start ImageBrowser, and
the initial window is displayed as shown below. Then the Browser Window appears.

4D

IrmageBrowser

When the Canon ImageBrowser alias icon is not displayed on the desktop, open the ImageBrowser
folder, in which the ImageBrowser program has been installed, and double-click the ImageBrowser
icon in the folder to launch.

Refer to Using the Browser Window for more information on this window.

Canon Canon Utilities
ImageBrowser

Starting ImageBrowser
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Using ImageBrowser

This section provides an overview of ImageBrowser and its functions.

* Using the Browser Window

* Changing the Appearance of the Browser Area

* Organizing Images

* Editing Image Using Image Viewer

* Slide Show

* Time Tunnel

* Adding Sound to Image

* Creating Image Files Attached to E-mail

* Creating Panoramic Photo Using PhotoStitch

* Opening Image Selected in the Browser Area from Other Applications

15



Using the Browser Window

This section describes the names and functions of the areas and buttons in the Browser Window,
the main window of ImageBrowser.

O | Browser Window——————— 08
@ Canon Camera
w = Macintosh HD
[ ] application
'3 @ Applications (M4 (2) Browser
> u Desktop Folder area
= u image Librar: |
(1) Explorer & e
Vi ew G§ samples
m LT SMPIMG37.JPG
— (7) Thumbnails
(3) Control R Q W &
panel ' CANON GAMERA SE:ECT 5_%22;:’ REDILICE ENLARGE DISPLAY IMAGE PRINT
] T« ] b
4 Total: 6 images |7
(4) CANON CAMERA | (5) SELECT ALL (6) The number of images
button button contained in the folder is

displayed.

Using the Browser Window 16



(1) Explorer View

This view presents the names of your hard drives and the folders contained in the hard drives.
When your Canon digital camera is connected, double-click the Canon Camera icon to open
the Camera Window, where the images stored in your digital camera are displayed.

(2) Browser area

The Browser area presents the images in thumbnail format contained in the folder currently
selected in the Explorer View.

The View menu allows you to change display settings such as the size of thumbnails, the
items displayed, and the display mode.

Refer to Changing the Appearance of the Browser Area.

(3) Control panel
This area contains several buttons to manipulate the images in the Browser Window.
(4) CANON CAMERA button

Click this button to access your Canon digital camera connected to your computer, and
download the images in the camera to display in the Camera Window.
Refer to Using the Camera Window.

(5) SELECT ALL button

Clicking this button selects all images in the Browser area.
(6) The number of images contained in the folder is displayed.
(7) Thumbnails

Thumbnails are reduced images contained in the selected folder in the Explorer View. Click a
thumbnail to select its associated image.
To select multiple images, click each thumbnail while pressing the Shift key.

Using the Browser Window 17



(2) REDUCE button (4) DISPLAY IMAGE button

Eilmﬁfﬁéa @%%

CANDN CAMER & SHELEET =die vo REDUCE ENL ARGE DISPLAY IMAGE PRINT

S T P

(1) SEND TO TRASH button (3) ENLARGE button  (5) PRINT button

(1) SEND TO TRASH button
Click this button to delete the selected images (image files) in the Browser area.

(2) REDUCE button

Click this button to reduce the size of thumbnails displayed in the Browser area. You can also
use the Reduce and Enlarge commands in the View menu to change the size of thumbnails
displayed in the Browser area.

(3) ENLARGE button

Click this button to increase the size of thumbnails displayed in the Browser area. You can also
use the Reduce and Enlarge commands in the View menu to change the size of thumbnails
displayed in the Browser area.

(4) DISPLAY IMAGE button

Click this button to display the selected image (thumbnail) in the Image viewer.
Refer to Editing Image Using Image Viewer.

(5) PRINT button

Clicking this button opens the submenu from which you can select either the Layout printing
or Index printing. Refer to Printing.

Using the Browser Window
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Changing the Appearance of the Browser Area

The Browser area of ImageBrowser presents the images and their associated information
contained in the selected folder in the Explorer View.

The information on the image appears.
The display format can be changed. Refer to Changing Display Options.

- — Thumbnail

The size can be changed.

1 SMPIMG35.JPG SMPIMG36. PG SMPIMG3T. PG
92K 128K 128K
Tuesday, September 4, 2001 Tuesday, September 4, 2001 Tuesday, September 4, 2001
11:08:56 AM 11:08:56 AM 11:08:56 AM

D

Browser area

The display format can be
changed.

Refer to Switching to the Preview
Display.

®

CANON CAMER A FELACT =L REDUICE ENLARGE  DISPLAY IMAGE PRINT

Changing the Appearance of the Browser Area 19



Switching to the Preview Display

The selected image can be previewed. In this mode, the image is sized and displayed so that it fits
in the Browser area.

Canon Camera S5ound Internet Wind
Mew Browser Window |

e List
View Settings M TimeTunnel
5% v Preview

50%

Tix
~ 100%

200%

Enlarge ¥+
Reduce 8-

View Actual Image

Slide Show...
Slide Show Options...

Refresh ¥R

SMPIMG35.0PG SMPIMG36.0PG SMPIMG3T.JPG  SMPIMG38.JPG  SMPIMG39.JPG  SMPIMGH0.IPG

92K 128K 128K 108K 136K 124K
KD
CANDN CAMERA el it REDLICE ENLARGE  DISPLAY IMAGE FRINT

ALL TRASH P

Select the View Mode from the View menu, and then select the Preview from the submenu that
appears. The mode switches to the preview display mode.

Select the List from the submenu to return to the list mode.

Changing the Appearance of the Browser Area 20



Changing Display Options

You can control what information about an image is displayed below the thumbnail.

Select the View Settings from the View menu, and then select the information you want to display
from the submenu that appears.

Canon Camera 5ound Internet W
New Browser Window

View Mode 3
- - v File Name \\

»* Shooting Date | [ SMPIMG35.0PG

25% i i [
S0% + Shooting Time — s Tuesday, September 4, 2001

5% + File Size — ———  11:08:56 AM
» 100% " Control Panel

200% Sound Panel

Enlarge 3+

Reduce -

View Actual Image

Shide Show...
5hide Show Options...
Refresh R CANOM CAMER A SEp'fLCT

Changing the Appearance of the Browser Area
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Organizing Images

Changing the Location of Images

To place an image to a different folder, simply drag and drop it (its thumbnail) in the Browser area
onto another folder in the Explorer View.

You can copy an image to a different folder by
dragging it while pressing the Option key.

SMPIMG10.JPG SMPIMG11.JPG
116K

Tuesday, September 4, 2001 Tuesday, September 4, 2001 Tuesday. September 4, 2001

11:08:56 AM 11:08:56 AM 11:08:56 AM

Drag and drop an image (its thumbnail) onto the
folder you want to place it.

SMPIMGO9Copying.IPG
88K

The folder where the selected = & s
image is stored.

SET eI o um omerbesran

TRASH
ToloT 4 imeaes [

The figure below shows the steps to create a new folder.

Organizing Images




(1) Select the folder in which
you want to create a new
folder.

O

[ﬁ Canon Camera
- = Macintosh HD

[ m application
[ @ Applications (M.
[ E'I Desktop Folder
e m Image Library O
m My Images

A m Samples
5§ Building
- m Nature

To move a folder to a different location in the Explorer View, drag and drop it onto another folder. You

(2) Select the New Folder from the

File menu.

m&lit Wiew Canon Camera S5ound Internet Win

Open...
Close
Save...

0
EW
S

New Folder
Duplicate
Send to Trash

Convert RAW Images

Convert RAW Images with User Defined Parameters...

Page Setup...

Print

Multiple Page Print...
Multiple Page Print Options...

»

Get Info...

31

Quit

#Q

An untitled folder is created and its name
can be entered.

4

&3 canon Camera
= Macintosh HD

E‘l application

m My Images
Ei Samples

Cj Buildings
m MNature

f:l Animals

W vuntitled Folder

G Birds

can copy a folder to a different location by dragging it while pressing the Option key.

Organizing Images
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To delete an image, select its thumbnail in the Browser area and click the SEND TO TRASH button.
To delete a folder, select the folder in the Explorer View and click the SEND TO TRASH button.

aa

SMPIMGO9CopyingJPG SMPIMGI0.JPG SMPIMG11.JPG
88K

Tuesday, Septerber 4, 2001 Tuesday, September 4, 2001 Tuesday, September 4, 2001
11:08:56 AM 11:0856 AM 11:08:56 AM

4
a a
{;ecoarace az:

a

EEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEEE

4
ES
2
[}
£

/
(1) Select the image you (2) Click the SEND TO (3) The selected image is deleted.
want to delete. TRASH button.

Note >» Wwhen you delete an image that has not been imported but is just displayed in the
Browser area, the image is deleted from the memory card of the camera.
Even if you delete an image by clicking the SEND TO TRASH button, it is just
moved to the Trash. To completely delete the image files contained in the Trash,
select Empty Trash from the Special menu in the Finder.

Organizing Images 24



When you create a new folder, or move, copy or delete an existing folder in the Finder, these
changes are not reflected immediately in ImageBrowser. In cases where you have managed files or
folders in the Finder or other applications, select the Refresh from the View menu to update the
contents of the Browser area.

Organizing Images 25



Editing Image Using Image Viewer

To display an image in the Image viewer, click its thumbnail in the Browser area to select it and click
the DISPLAY IMAGE button to run the Image viewer.

Use the Q ENLARGE button or the Q REDUCE button to magnify or reduce the size of the
image.

HE The Image viewer is also invoked by double-clicking an image
(thumbnail) in the Browser area. You can perform such actions as
image cropping, color adjustment, and saving of modified images.

I SMPIMG1 4.0PG

SMPIMG14.JPG
80K
2001 Tuesday, September 4, 2001
11:08:56 AM

ENLARGE Q&PLAV MAG> PRINT

-

T Total: 18 mages | %

DISPLAY IMAGE button

Click this button to invoke the Image viewer. (G s D C
The size of the image is The display scale of
displayed. the image appears.

Editing Image Using Image Viewer



Cropping Image

Select the portion of the image you want to keep by mouse-dragging over it, and then click the
CROP button. Area outside the selection is trimmed away.

Cropped area

[ SMPIMG14.0PG

: -
7 o
[ =1
oe wor T e i ae e
‘ et 7
[oisplay: 100% |7 Inage Size . SeewATd (250,320 [ Display:_100% [

CROP button
Clicking this button will trim the area outside the selection.

Editing Image Using Image Viewer



You can change the hue, saturation, and lightness of the image displayed in the Image viewer.
Clicking the ADJUST COLOR button opens the Adjust Color dialog box, which allows you to make
color adjustments.

The Hue, Saturation, and Lightness
are adjustable.

Adjust Golof —

Hue: o

Saturation: )
'

- 0

Click the OK button to make the
changes take effect.

Image Size: _768x912 [ [oisplay: _100% [

ADJUST COLOR button
Click this button to open the Adjust Color dialog box.

Editing Image Using Image Viewer
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The modified image file can be saved with a new name.

i) =]

Tersee Temes |

e

( ﬁ} e 5 e
SAVE button

Clicking this button opens the Save File window.

save fleP———
e 5 ol
Date Modified [ =]

25101 I E

EA 55101 jpa F/30401 =

[E AMIMALDDZ 5101 .JPG F/30401

[ AMIMALDO3 5101 .JPG F/30401

7 BASEBALLO1_SI01 JPG 5430401

[ FuUNO1_5101.JPG 8730401

— =
Name; IUntitIed I [ New ]
| FormatAF IPEG 3
[57‘ [ Cancel ] H Save ]|

2 |

Type in a file name and specify the file type,
and click the Save button. The image is
saved as a new file.

Editing Image Using Image Viewer
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You can review sequentially the selected images in the Browser area as a slide show in full screen

mode.

Steps

Choose the Slide Show Options from the View menu.
The window containing options for a slide show opens.

Slide Show Options

— Play Method

& Auto Play

Play Interval :@:& 4  Sec

(2} Control with Mouse or Keypad

[ Repeat Continuously

] Hides buttons

— Transition Effect

Random i] A

[ Cancel ] ” 0K ]l

Slide Show
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Specify the playing mode and options for slide show.
The window allows you to specify the following options:

Auto Play: When you select this option, specify the interval of image switching with
the slider.

Repeat Continuously: When this radio button is selected, the slide show is
repeated endlessly, working as a screen saver. Press the ESC key to exit the slide
show.

Specify effects for slide show.
Click the | ¥ I button to choose from the following effects:

Random: Images are randomly selected and arranged to be displayed on the
screen.

Fade: The current image fades out to be replaced with the next image.

Slide: The current image is replaced with the next image sliding from the specified
side.

Push: The current image is pushed away in the specified direction to be replaced
with the next image.

Wipe: The current image is overwritten by the next image from the specified side.

Zigzag: The current image is overwritten by the next image from the specified side
with a zigzag-shape boundary.

Click the OK button.
The window for the slide show options closes to return to the Browser Window.

Slide Show
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5 Select images in the Browser area you want to display as a slide show.

m Browser Window =—"—"———————————————————— B

SHMPIMG23.JPG SHMPIMG24. PG SMPIMG25.JPG
96K 128K 136K
Tuesday, September 4, 2001 Tuesday, September 4, 2001 Tuesday, September 4, 2001
11:08:56 AM 11:08:56 AM 11:08:56 AM

(i} Q ® ‘q 5

daan EENED) REDUCE EWLARGE  DISPLAY IMAGE PRINT

CANON CAMERA ALl TRASH

Slide Show 32



Select the Slide Show from the View menu.
The selected images are sequentially displayed in full screen mode.

The slide show terminates when the last image has been processed.

Slide Show
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The following buttons are displayed when you invoke the slide show function.

¥ % | @@@ > » | 5

T A T A T A T T
Deselect/ Return to Pause Display last Close slide
Select first image image show
image(s) in
the Browser
Window

Mark images for Return to Display next
printing previous image
image

Deselect/Select image(s) in the Browser Window
Clicking this button will deselect the current image (selected in the Browser area). Click again
to select the same image.

Mark images for printing

If you want to print the current image, click this button while it is being displayed. When the
slide show ends, the program automatically proceeds to the layout printing. Click again to
disable the printing of the image.

Return to first image
Click this button to go back to the first image.

Slide Show 34



Return to previous image
Click this button to return to the previous image.

Pause

During the auto play, click this button to suspend the slide show.

Click again to resume the slide show.
Display next image

The next image is displayed.
Display last image

The last image is displayed.
Close slide show

Exits the slide show.

Note that these buttons will not be displayed when the Hides buttons check box in the Slide Show

Options dialog box is checked.

Slide Show
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When you select the View Mode, then Time Tunnel from the View menu, the Browser area
changes to the Time Tunnel display mode. In this mode, the images contained in the selected folder
appear in the Browser area as if you were in front of the entrance to a time tunnel. Images are
allocated to the walls in order of creation date.

Drag the slider in the floating pallet displayed to the right of the Time Tunnel window to show older or
newer images. The Tool Pallet allows you to change the appearance of the Time Tunnel window.

When you select a different folder in the Explorer View, the images in that folder are shown in the
Time Tunnel window.

S

Drag the slider to zoom in/out of
/ the time tunnel.

Menu button

Clicking this button displays the

gl - popup menu in which you can
select the Display Tool Panel,

8/29/01 O octagonal s 3] 5| <€— Tool Panel Auto Cruise, etc.

[ winding Tunnel

2E

2o om

GRaereacasz

To return to the standard Browser area mode, select the List item from the submenu that appears
when you point to the View Mode command in the View menu.

Time Tunnel
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ImageBrowser enables you to add sound (audio data) to an image file. The sound input device
selected in the Sound Panel is used for recording.

Steps for Recording
Select the image to which you want to add sound.

Select the Record from the Sound menu.
The Record panel is displayed over the Browser Window.

° bl
00:00:00 []

Click the ﬂ Record button to start recording. The Record panel during
recording is as shown below.

u
o))
*

Adding Sound to Image
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To finish recording and save the sound data, click the Save button.
The recorded sound data is saved as a sound file. A mark appears in the bottom

left corner of the selected image (thumbnail), indicating that sound data is attached
to that image file.

SMPIMG1.IPG

The created sound file is stored in the same folder as the image file.

Steps for Playing

Select the thumbnail that has a sound mark in the bottom left corner.
Select the Play from the Sound menu.

Adding Sound to Image 38



When you select the Sound Panel from the View Settings submenu in the View menu, the Sound
Panel is displayed.

The buttons on the Sound Panel provide convenient access to the commands in the Sound menu.

Stop Pause Record Play Volume slider

[ A R W

G @ o B @« @« @ B

SELECT SEND TO
CANOM CAMER & AL TRASH REDLCE EML ARGE DISPLAY IMAGE FRINT

Adding Sound to Image
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ImageBrowser allows you to quickly edit the image selected in the Browser area and attach them to
E-mail using the wizard.

Select the image you want to attach to your E-mail in the Browser area. Choose the
Create image for Email command from the Internet menu to open the Create
image for Email dialog box. At the same time, the wizard starts.

Select the Resize and Compress image(s) into JPEG format option.

If you select the Send image(s) without compression option, the image data will
be sent with your message as it is (not compressed).

Click the Next button.

Create Image for Email

Create an image file at an appropriate size for sending as an email
attachment. In general, it is recommended to keep the total size less than
300KB. Choose option and click [Next].

(2} Send image(s) without compression

) Resize and Compress image(s} into JPEG format

Number of Images: 1
Total Size Before Compression:28KB

” Next = ]I [ Cancel ]

Creating Image Files Attached to E-mail 40



In the next wizard dialog box, specify the Resize rate and the quality of JPEG data.
When you click the Compress button, the calculated file size after compression is

displayed at the bottom of the dialog box.
Click the Next button.

Create Image for Email

it is recommended to keep the total size less than 300KB.

Quality: \:@:t
I I I I I

Low High

Set resizing and quality factor. Click [Compress] to compress images. In general,

Number of Images:1
Total 5ize Before Compression: 28KB
Total Size After Compression:

< Previous ] ” Next = ]l [

Cancel ]

Creating Image Files Attached to E-mail
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In this dialog box, specify the action after data compression.

If you select the Start email application after closing check box, your E-mail
application will automatically start upon completion of data compression.

Click the Preview button to preview the image that has been compressed.
Click the Finish button.

Create Image for Email

Click the [Finish] button. The image for attaching to an email message will
display in the Browser Window. Attach this image to your email message.

[ start email application after closing

Number of Images:1

Total 5ize Before Compression: 28KB

Total 5ize After Compression: 45KB

< Previous ] ” Finish ]l [ Cancel ]
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A new folder called Email Images is created in which the compressed image is

stored.

To attach the compressed image to your E-mail message, drag and drop the
thumbnail in the Browser area onto your message in your E-mail application.

O

n Browser Window

-
B
3
B

-

E& Canon Camera
. Email Images
=3 Macintosh HD
m application
@ Applications
m Desktop Fold,
m Image Librar:
m My Imag

@ samp

§ Buildi

n Natui
Q
{ s
§ -

SMPIMG18.jpa
48K
Tuesday, September 4, 2001
6:28:27 PM
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Creating Panoramic Photo Using PhotoStitch

PhotoStitch is an utility program for quickly creating a panoramic photo by merging multiple images
captured with your digital camera.

1 Select multiple images (thumbnails) in the Browser area and select the
PhotoStitch from the Edit menu.

=————— BrowserWindow—— [ H

===

H_03.jpg H_04.jpg H_05.jpg

83K 8BK 88K
Sunday, May 9, 1999 Sunday, May 9, 1999 Sunday, May 9, 1999
2:25:28 PM 2:25:40 PM 2:25:48 PM

Creating Panoramic Photo Using PhotoStitch
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PhotoStitch starts and loads the selected images.

[a] i oE|
Merge Images Shot in Stitch Assist Mode :‘

Click [2. Merge] to merge these images.
For images shot a5 8 360-degree panorama, click lArrengel, select
[360 Degrees] and then click [2. Merge]

1. Selection and Arrangement ‘ 2. Merge ‘ 35ave

= %
=] P

KD
Wo_of Images: 3| [ S12x 384 True Cowr %

With PhotoStitch, you can merge any number of images vertically or horizontally,
producing unique posters or other photo-prints. The wide-mode merging feature is
also useful when you want to create a wide panoramic photo of a building or
straight-lined object with straight lines as natural as the original.

Creating Panoramic Photo Using PhotoStitch
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ImageBrowser allows you to register other application programs. You can start the registered
application programs from ImageBrowser and open the images displayed in the Browser area using
those programs.

Open the Preference window by selecting the Preference from the Edit menu.

Preferences
_[ Browser Window = I
— Thumbnail Area
Frame Color [ ] selection Color I Cancel I
Background Color :I
— Preview Area
Background Color

]

b Create Custom lcon for Image Files
— Reqgister Application

Delete

Opening Image Selected in the Browser Area from Other Applications
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Click the Add button to the right of the Register Application list box. Select the application
program you wish to register in the Select File dialog box that appears.

Click the OK button to complete the registration.

To run a registered application program, select an image in the Browser area and then select the
name of the application program from the Start Application submenu in the Edit menu. The
specified application starts, and the selected image is loaded to the application.

Refer to the documentation of the invoked application program for more information about how to
use it.

Opening Image Selected in the Browser Area from Other Applications
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This section describes the functionality of ImageBrowser to import/download images from your
digital camera.

* Importing Images with the Automation Wizard

* Importing Images Using the Camera Window

* Using the Camera Window

* Setting Up Your Canon Digital Camera
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The Automation wizard takes you through all the necessary actions from importing images to
printing. The wizard is invoked when one of the following conditions is met:

When you turn on your Canon digital camera
connected to your computer, while ImageBrowser is
not running.

ImageBrowser starts and then the Automation
wizard is invoked.

When you turn on your Canon digital camera
connected to your computer, while ImageBrowser is
running.

When you turn on your digital camera, which is not
manufactured by Canon, while ImageBrowser is
running.

When you insert the memory card into the memory
card reader, while ImageBrowser is running.

The Automation wizard starts.

Note » some digital cameras may not be compatible with the automatic execution feature.

Importing Images with the Automation Wizard
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When the Automation wizard starts, the following dialog box containing several options is displayed.

ImageBrowser Automation wizard

Digital camera image{s) has been found. Please select an action from the
following.

@ Display Images
() Download images

(You can set the detailed settings in the dialogs that follow.)

Macintosh HD:My Folder1:09_04_2001
Cancel ] ” 0K ]l

Select Download images if you prefer the automated image downloading with the Automated
wizard. See Setting the Automation Wizard to Download Images.

Importing Images with the Automation Wizard
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Your settings in the ImageBrowser Automation wizard dialog box are saved. The next time the
Automation wizard starts, the ImageBrowser Automation wizard dialog box shows the previous
settings as shown below:

ImageBrowser Automation wizard

Digital camera image(s} has been found. The following action was selected
previously. Execute same action?

Display Images

Cancel ] l Settings change ] ” Start ]I

ImageBrowser Automation wizard

Digital camera image{s)} has been found. The following action was selected
previously. Execute same action?

Download images
Image type:Download all images

Operation after downloading:Do nothing

Cancel ] [ Settings change ] ” Start ]I

Click the Start button to use the saved sequence of actions.

If you do not want to use the saved action sequence, click the Settings change button to change
the saved settings.

Click the Cancel button to exit the Automation wizard and return to the Browser Window.

Importing Images with the Automation Wizard
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Follow the steps below to download the images stored in the device connected to your computer
with the Automation wizard.

Steps

Select the Download Images option in the ImageBrowser Automation wizard
dialog box.

The Change button becomes active.

ImageBrowser Automation wizard

Digital camera image(s) has been found. Please select an action from the
following.

) Display Images

@® Download images
{You can set the detailed settings in the dialogs that follow.)
Save to: Change ] The downloaded images are saved to the

Macintosh HD:My Folder1:09_05_2001 .
folder displayed here. To change the

destination folder, click the Change
button and select a destination folder.

Click the Next button to proceed.
The dialog box shows the following options:

ImageBrowser Automation wizard — Download all images
Your images will be downloaded automatically. Please select an action SeleCt thIS OptiOn to dOWnload a” the images.
Download images marked for printing
© Download alimages Select this option to download only the images
Do (S G =) R selected for printing (DPOF).
D Download images marked for transterring Download images marked for transferring
(Gome moits o suppart s function) Select this option to download only the images
selected for attaching to your E-mail.
cancel | [ <Back | | 0K |
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Select a category of images to download with the Automation wizard.

Refer to the documentation of your Canon camera for more information on how to
select an image depending on its use (for printing or E-mail attachment).

Click the OK button.

The Automation wizard starts downloading the selected images and saving them in
the selected folder.

When downloading is complete, the following message appears:

=——————— ImageBrowser Automation wizard

Downloaded images saved to the following folder.
Macintosh HD:My Folder1:09_05_2001

If you want to do one of the ing with the images, please
select that action.

) Display slide show
() Launch the Print window
() Print with Index printing

) Create image for Email

[ Cancel ] ” OK ll

Select the next action to do on the downloaded images from the following options:

Option Action

Display slide show | Select this option to view the downloaded images as a slide show.

Launch the Print Select this option to perform custom layout printing (all images are
window automatically selected and printed).

Print with Index Select this option to perform index printing (all images are
printing automatically selected and printed).
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Create image for Select this option to open the Create Image for Email dialog box
Email (all images are automatically selected).

Refer to Creating Image Files Attached to E-mail for more
information.

Click the OK button.
The Automation wizard terminates and the selected action is performed.

If you click the Cancel button, the Automation wizard terminates to return to the
Browser Window with no action performed.

When the Automation wizard terminates, it saves the selected settings so that the
ImageBrowser Automation wizard dialog box shows the settings the next time
the wizard starts.

Importing Images with the Automation Wizard
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The Camera Window is invoked when one of the following conditions is met:

Condition

Data displayed in the Camera Window

When you select the Display Images option in the
Automation wizard.

All the images stored in your device that can be
recognized by the Automation wizard, such as a
digital camera or a memory card.

When you double-click the DCIM icon in the
Explorer View.

All the images stored in the DCIM folder in the
memory card or the smart media.

*The folder name, DCIM, may be different depending
on the type of data stored in the memory card used
or the hard drive connected. For example, the folder
name may be DC97 or PWSHOTO.

When you click the CANON CAMERA button.

When you click the Canon Camera icon in the
Explorer View.

The images stored in your Canon digital camera
connected to your computer.

This section describes how to import or download the images to ImageBrowser using the Camera

Window.
Note

» e Ensure that adaptors for the memory card reader or the memory card are installed

correctly on your computer before importing image data saved in the memory card.

* Your Canon digital camera must be connected correctly to your computer to open
the Camera Window using the CANON CAMERA button or the Canon Camera

icon.

Importing Images Using the Camera Window




The images in the device are displayed in the Camera Window (in thumbnail
format).

Oo=———————————— —~mwnania =————— ﬁi

| I K1
IMAGE SLIDE/
FOTATE  upLosD HFO CPOF

2 B

pownLoan  PRINT

) Gy I

SETUP CONNECT
OPTIONS: CAMERA

SELECT DELETE

Total: 8 images | 7.

Refer to Using the Camera Window for more information on this window.
Select the folder where to save the images in the Explorer View.

Refer to Changing the Location of Images for more information on dealing with
folders, including creating a new folder.

Return to the Camera Window and click each image you want to import.

When you click an image (thumbnail), its background color changes to blue,
indicating it has been selected.

Ie—————— el ——————————§

I K1Y
IMAGE SLIE/
INFO DPOF

® B

FRINT

) g &

SETUP COKNECT ROTATE
OPTIONS CAVERA SELECT  DELETE | DOWNLOAD URLOAD

60001 PG Total: 8 images | 7
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You can select multiple images by clicking desired thumbnails while pressing the
Shift key.

O————————mnaal————— [

—E
B o @

Y DIGITA
SETUP COKNECT FRINT ROTATE IMAGE SLIDE/
OPTIOHS CAMERA SELECT  DELETE | DOWNLOAD URLOAD D DROF

Total: & images |

Click the DOWNLOAD button in the Camera Window.

The selected image(s) is imported to your computer and displayed in the Browser
area.

O=——————— (Biowserbviniw———— HIH

&) Canon Camera
b S GHIIMA

m

100-0001_IMG.IPG 100-0002_IMG.IPG

|

100-0004_IMG.IPG 101-0130_MG.IPG 101-0131_AUT.JPG
5 & o ity Q, Y g l
- = SELECT SEMD TO o o !
ok CANON CAMERA e REDUCE ENL ARGE DISPLAY IMAGE PRINT
o .
Total: 10 images [ 7.

Click the close box at the upper left corner of the window.
Repeat Steps 3 and 4 above to import other images.
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The Camera Window shows the images saved in the device connected to your computer.
You can display the information on each image in the device, as well as import or print these images
using the Camera Window.

Click an image (thumbnail) to select it. The border is displayed around the selected image. You can
select multiple images by clicking each image while pressing the Shift key.

Images (thumbnails) in the Thumbnails
memory card are displayed. The thumbnails of the images in the memory card are displayed.
When you click a thumbnail, its background color changes.
|
=]

] %IW DIGITAL

@@

mSDETT|;|;s ETN;RCI SELECT DELETE | DOwmLoaD  FRINT ROTATE  ypLoap "L?EE S,';';I.DDEFK
Total: 19 images [
(1) SETUP (3) SELECT (6) PRINT |(8) UPLOAD|  (10) SLIDE/DPOF
OPTIONS button button button button
button
(5) DOWNLOAD
button
(2) CONNECT (4) DELETE (7) ROTATE (9) IMAGE INFO button
CAMERA button button button

Using the Camera Window
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(1) SETUP OPTIONS button
When the SETUP OPTIONS button is selected, a menu is displayed.

Items in the menu

Features

Camera Settings

Selecting this item displays a dialog box, which shows the information on
the connected camera such as owner’s name and date. The information
in this dialog box can be modified.

Communication Settings

Selecting this item displays a dialog box, which shows the settings of the
connected camera such as the communication port the camera uses.
The settings can be modified.

Note >» This button is available only when the connected device is a Canon digital camera.

(2) CONNECT CAMERA button

To re-establish the connection between the device and the computer and download the images in
the device again, click the CONNECT CAMERA button.

Note >» This button is available only when the connected device is a Canon digital camera.

(3) SELECT button

Click the SELECT button to open a menu containing two items Select All and Deselect All. Click
Select All to select all the images displayed in the Camera Window. Click Deselect All to deselect
all the images displayed in the Camera Window.

Using the Camera Window
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(4) DELETE button

Click the DELETE button to delete the selected image from the device. When clicking this button, a
warning message is displayed asking you to confirm the deletion.

Click the OK button to completely delete the image from the device. Click the Cancel button to
cancel the deletion. The deleted image is not recoverable.

(5) DOWNLOAD button

Click the DOWNLOAD button to copy the selected image(s) to the folder selected in the Explorer
View.

When you click an image(s) and click this button, downloading starts and at the same time a dialog
box indicating the progress of downloading appears.
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(6) PRINT button

Click the PRINT button to print the selected images. This button works the same as the PRINT
button in the Browser Window. This button allows you to start custom layout printing or index printing
directly from the device (images are not imported to your computer).

Layout Options

DIGITAL B

How would you like to print your photas?
® Custom layout printing

G Index printing

QO Fixed photo size printing

QG Tiled photo printing

Q Canon perforated paper printing

Prints each image at the individually
specified size and position.

COMNEET
CAMERA

IHAGE sLibEs
ROTATE
XD INFO OFOF

i 5] EE]
]
[ADisplay this dialog when the Print window displays

Canon 5330

version 4y ————

3

<

F
isplay this cialo when the Print windaw displays 5 ot [

Goneel ) ([_ma _J[_ok__] FeLia ROTATE

H o

LavauT
oprons  PRNT

IMAGES
PER PAGE

Refer to Printing for more information on the custom layout printing and index printing.
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(7) ROTATE button

The ROTATE button allows you to rotate a thumbnail in the Camera Window. When you select a
thumbnail and then click this button, a submenu appears.

Select 90 degrees right to rotate the selected thumbnail 90 degrees clockwise.
Select 90 degrees left to rotate the selected thumbnail 90 degrees counterclockwise.
Select 180 degrees to rotate the selected thumbnail 180 degrees.

These rotation options will rotate only the selected thumbnail displayed in the Camera Window (the
original image stored in the device is not rotated). However, when you import the image of a rotated
thumbnail, it is automatically rotated according to the rotation option and downloaded to the
specified folder.

Note >» when you import the image of a rotated thumbnail, the original image (not rotated)
is also downloaded in addition to the rotated image. To prevent the original image
from being downloaded, select the File Format option from the pulldown menu at
the upper left corner of the Preferences dialog box and then check the Retain
original when rotating JPEG images check box. The Preferences dialog box is
displayed by selecting Preferences from the Edit menu.
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(8) UPLOAD button

Use this button to export or upload an image located in a folder on your computer to the device.
Clicking this button displays the dialog box where you can select an image file.

= selectimageshhaldl ="="—————
(Deskip )
I . Date Modified |F
- H = : B/8/01
b 3§ urL 197701 g
b [ settings 19/7/01 -
b 3 print 1977701
b 3 MyCameraFiles 24/8/01 —
b [ camers 3/8/01 B
[@] [ cancer J|[ open J
e

When you select an image to upload in the dialog box, the following dialog box appears.

Save 10 Camera - IXY DIGITAL

1/1 Images

[ Adjust Height

[ Adjust Width

Camera Model | ey DiGITAL =1

Save subsequent images with the same settings | [ Cancel ] H Save to Camera ]l

Specify uploading options such as image size and resizing options, and then click the Save to
Camera button to start uploading the image to the device.

Note » an image in the Browser area can be uploaded to the device by dragging and
dropping it onto the thumbnail area of the Camera Window.

Using the Camera Window
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(9) IMAGE INFO button

This button enables you to view the information on an image selected in the Camera Window.

Select an image in the Camera Window and then click the IMAGE INFO button. The following dialog

box appears.

= jmage hformatione————————

File Name
IMG_0004.JPG

Camera Model Name
Canon IXY DIGITAL

Shooting Date/Time
01706701 19:43:09

Shooting Mode
Auto

Tv{Shutter Speed}
17180

Av(Aperture Value)
2.8

Metering Mode

Using the Camera Window
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(10) SLIDE/DPOF button

Click the SLIDE/DPOF button to open the Edit Slide/DPOF window.

Edit Slide/DPOF - IZY DIGITAL
() SlideShouw
@) Print Order{DPOF ) \# ﬁ
Save ta Camer a Edit Help Quit
[ Standard Print =
1417 417 5417
6417 917 10417
= L= = L =
1417 12017 1317 14417 15417
[pate and Time: [File Name -

Standard - 0

Using this window, you can modify the settings for slide shows or DPOF for your Canon Digital

Camera and write the modified information to your camera.

Note

»  Only Canon digital cameras support the functions provided by this button.

Using the Camera Window
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This section describes how to set up your Canon digital camera to connect to your computer. Only
when your digital camera is communicating with your computer correctly, the Automation wizard is

available. Double-clicking the Canon Camera icon in the Explorer View displays the Camera
Window.

Communication Settings

Select the Communication Settings option from the Settings submenu in the Canon Camera
menu to display the following dialog box.

=————— Communication Settings =—F—0——

Port: [USB Port i]
Detected Camera  [IxY DIGITAL B
[ Cancel ] ” Set "

Note >» When setting up the communication between your computer and digital camera,
ensure that the driver of your digital camera has been installed correctly and your
digital camera has been connected to your computer. Also turn on your digital
camera before starting the setup.

ImageBrowser may not recognize some digital camera models.
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The Canon ImageBrowser Auto Launch control panel is installed onto the Control Panels folder at
the time of ImageBrowser installation. This control panel allows you to specify the action when a
Canon camera is detected.

Double-click the Canon ImageBrowser Auto Launch control panel located in the
Control Panels folder. The Settings for USB connection dialog box appears.

[gg Canon ImageBrowser Auto Launch

[0 = settings for USB connection =———=8H
[ The application program below will start.
Program Name: | ImageBrowser 3]
— Program Selection Options
@ Auto Select
(O Selectwith the Dialog

Startup Program

To automatically start ImageBrowser and run the Automation wizard when a digital
camera is detected, check The application program below will start check box
and select the ImageBrowser option from the Program Name pulldown menu.
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If the Select with the Dialog radio button is selected in the Program Selection
Options group box, a dialog box that allows you to select an application program
will open when a digital camera is detected.

Click the close box at the upper left-hand corner of the dialog box to close the
Canon ImageBrowser Auto Launch control panel.
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This section describes ImageBrowser’s printing features.

These features can be accessed by displaying the Browser Window or the Camera Window and
clicking the Print button.

* Custom Layout Printing

* Fixed Photo Size Printing

* Tiled Photo Printing (Borderless Printing)

» Canon Perforated Paper Printing

* About Canon Perforated Paper

* Starting Printing

* Index Printing
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Custom Layout Printing

Selecting a Layout

The layout selection wizard lets you quickly select a desired layout for printing.

Steps

1 Select the image you want to print in the Browser area, and select Layout printing
from the submenu that appears when clicking the PRINT button.

Index printing...
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The Layout Options window appears and, at the same time, the layout selection

wizard starts. Select the Custom layout printing radio button.

Layout Options

How would you like to print your photos?
@ Custom layout printing
(O Index printing
(3 Fixed photo size printing
(3 Tiled photo printing
() Canon perforated paper printing

Prints each image at the individually
specified size and position.

[ Display this dialog when the Print window displays

Click the Next button to proceed to the next page for page setup.

Layout Options

— Preview

Confirm the page setup.

Paper size :

Vertical297.0 X Horizontal209.9mm

[ Display this dialog when the Print window displays

Cancel ][ < Back

J

OK

J

Custom Layout Printing

71



Click the Page setup button.

The Page Setup dialog box for the printer selected in the Chooser appears. Specify
the paper size and orientation. Select the Borderless Printing check box to print

images with no margins.

Canon 5330

0K

|

[ Banner Printing

i

rding

=

E3

Paper Size : | Letter ¥ I

4 Borderless Printing
Amount of Extension :
Min, = Max.

Scale:

Height: 2r3.4mm Width : 215.9mm

Orientation :

[0 Save Settings

Custom Layout Printing
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Note

>

Click the OK button to complete the page setup.

The page size that you specified in the Page Setup dialog box is displayed under
the Paper size label in the Layout Options window.

Note that the Page Setup and Print dialog boxes shown here are of BJ S330.

= layput Iptinns =————

— Preview

Confirm the page setup.

The size of paper you specified in the | ey
Page Setup dialog box is displayed Vertical297.0 ¥ Horizontal209.9mm
here.

[ Display this dialog when the Print window displays

Cancel ] [ < Back ] [ OK ]

Click the OK button to exit the layout selection wizard.

The Print window appears where the selected images are arranged so that they fit
the page size you specified.

Page artwork

When the Custom layout printing option is selected, you can change the size and
position of the images as well as perform image cropping.

Custom Layout Printing
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Canon Perforated Paper Printing
Click the PRINT button to start printing.

O=—""—F———-rmrmn———————=~HEg

il
= L El@

RE-LAYOUT ROTATE IMAGES
v PER PAGE

<9

LAYOUT
OPTIONS LSl

Starting Printing
Click the PRINT button to begin printing.
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Page Artwork

When the Custom layout printing option is selected, you can change the size and position of the
images as well as perform image cropping. You can also add text information to the page.

O=——————pm=—————HH O=————————pmnt=———FHH O=——————rprm

AN A 1S
=y i e=] _l"
AYVOR =
2 BOCH S = B (B H <
=im (=] i =i L4, Ll
RE-LAYOUT  ROTATE IMAGES: ot PRINT RE-LAYOUT  ROTATE IMAGES S PRIT RE-LAVOUT  ROTATE IMAGES LAYOUT oo
¥ PERPAGE ¥ PERPAGE ¥ PERPAGE EETRNS,
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Steps to delete an image

1. Select the image you want to delete. 2. Press the Delete key on the keyboard.
A frame appears around the selected image.

The image is deleted.

You can also delete the selected image by selecting
Clear from the Edit menu.
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Cropping an image

1 Select the image you want to crop.
A frame appears around the selected image.

— Selected image

” Double-click the selected image.
The Clipping window appears in which the selected image is displayed.
You can also open the Clipping window by selecting Clipping from the Edit menu.
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3 Inthe Clipping window, drag the mouse to select the clipping area.

Clipping area

4 Click the close box at the upper left corner of the window to close the Clipping

window.

The image after cropping is displayed in the Print window.

Image after cropping

Refer to Cropping an Image for more information on the Clipping window and how

to crop an image.

Custom Layout Printing
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Moving an image (changing the position of an image)

1. Select the image you want to move. 2. Drag the image with the mouse to move to a different
A frame appears around the selected image. location.
O="—F—————mm=————"T—=u8 O=—"———"rmim=———=—H8

Image moved to a
different location

£ B 8

RE-LAYOUT  ROTATE IMAGES
¥ PER PAGE

<9

LAYOUT
OPTIONS FRHT

2 B E

RE-LAYOUT  ROTATE IMAGES
¥ PERPAGE

<

LAYOUT
OPTIONS: ER
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Enlarging and reducing an image (changing the size of an image)

1 Sselectthe image you want to enlarge or reduce.
A frame appears around the selected image.

" Place the mouse cursor over the border of the selected image, and drag the mouse
to enlarge or reduce the image.

When the mouse cursor is positioned over the image border, the cursor changes
into .

Custom Layout Printing
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Adding text
Select Add Text from the Edit menu.
The Add Text window appears.

Select the font used.
Select the font size.

Specify text’s justification.

= itexi=——————§
1

1
[Helvetica BIEEE | [ cancel |
Specify the font style. Available styles
and effects are (from left to right): @E

bold, italic, underlined, outline, shadow,
wide space, narrow space, and color.

ST

[«]¥
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Enter text in the text box.
You can specify text attributes such as font, font style, color and justification.

The entered text is inserted into the Print window according to the format specified
in the Add Text window.

s  Mmiilmil=—F——————
[Helvetica BIEE =
(B[ ][1] @] s [3] )~ m

MY
FAVORITE

ST
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Click the OK button.
The entered text is displayed on the Print window.

O=——————mm=———H8H

o | S =
il L, E

RE-LAYOUT  ROTATE IMAGES
v PER PAGE

LAYOUT
OFTIONS

Page headers and image titles can also be added. Refer to Inserting Text for more
information on headers and titles.

Starting Printing
Click the PRINT button to begin printing.
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Fixed Photo Size Printing

Selecting a Layout

Follow the steps below when performing fixed photo size printing.
Steps

7 I the Browser area, select the image(s) to print with the fixed photo size printing
option. Then select Layout printing from the submenu that appears when clicking

the PRINT button.

Index printing...

The Layout Options window appears and the layout selection wizard starts.
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Select the Fixed photo size printing option in the Layout Options window.

Layout Options

How would you like to print your photos?
(3 Custom layout printing
(J Index printing
@ Fixed photo size printing
(3 Tiled photo printing
(J Canon perforated paper printing

Aligns and prints all images at the same
specified size. As many images as
possible are fit to a page.

[A Display this dialog when the Print window displays

Click the Next button to proceed to the next page.

Layout Options
— Preview
Confirm the page setup and select the
print size for the image.
Paper size :
Vertical297.0 X Horizontal209.9mm
Photo Size:
[Custom ﬂ
L Jx [ Juom
B4 Auternatic Clipping:
[ Display this dialog when the Print window displays
[ Cancel ] [ < Back ] [ oK ]
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Click the Page setup button.

The Page Setup dialog box for the printer selected in the Chooser appears. Specify

the paper size and orientation.

Height:279.4mm Width :215.9mm

Canon 5330 version 4.0
0K
Paper Size : | Letter %
[ Banner Printing
ama [4 Borderless Printing
E:;ﬁi Amount of BExtension :
Min, ey Max.

scale: [50|2]) %

Orientation :

[ Save Settings

Click the OK button to close the Page Setup dialog box and return to the Layout
Options window.

The size of paper you specified in the
Page Setup dialog box is displayed. |

=—————  JapjomOptins———

— Preview

Confirm the page setup and select the
print size for the image.

Paper size :
Wertical279.4 ¥ Horizontal215.9mm

Automatic Clipping:

[ Display this dialog when the Print window displays

[ Cancel ] [ < Back ] [ 0K ]

Fixed Photo Size Printing
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6 Select the size of the photos.
Check the Automatic Clipping check box to automatically crop images so that
they fit the paper of the specified size.

Select the size of photos from the Photo Size pulldown menu. The Preview area
on the right side of the window shows how the selected images are arranged under
the current settings.

The figure below illustrates how the images are placed on A4 paper for each photo

size.

Select the Custom option when printing non-standard photos. In this case, you
have to specify the height and width of the photo.
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Click the OK button to exit the layout selection wizard.

The Print window appears where the selected images are arranged so that they fit
the paper size you specified.

Page Artwork

When printing using the fixed photo size printing option, you cannot change the
location and size of the images although the image cropping and text insertion
features are available.

Starting Printing
Click the PRINT button to begin printing.
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Tiled Photo Printing (Borderless Printing)

Selecting a Layout

Follow the steps below when performing tiled photo printing.

Steps

7 I the Browser area, select the image(s) to print with the Tiled photo printing
option. Then select Layout printing from the submenu that appears when clicking
the PRINT button.

Index printing...

The Layout Options window appears and the layout selection wizard starts.
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Select Tiled photo printing option in the Layout Options window.

Layout Optiohs

How would you like to print your photos?
(J Custom layout printing
(3 Index printing
{J Fixed photo size printing
@@ Tiled photo printing
(J Canon perforated paper printing

Specifies the number of images per page
and prints. Images are tiled on the page
1o allow them to be printed as large as
possible.

[ Display this dialog when the Print window displays

Click the Next button to proceed to the next page.

Layout Options

— Preview

Confirm the page setup and select the
number of images per page.

Paper size :
Vertical22 X Horizontal 17in

Page setup...

No. ofimages

101y =

4 Automatic Clipping:

Set Photo Area...

[ Display this dialog when the Printing window displays

Cancel ] [ < Back ] [ 0K ]
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Click the Page setup button.

The Page Setup dialog box for the printer selected in the Chooser appears. Specify
the paper size.

Canon 5330 Version 4.0

0K I
Paper Size : | Letter *
I [ Banner Printing
[4 Borderless Printing
Amount of [ Extension :
Min, gl Max.
To specify settings for the tiled photo Scate} 50 2) %
printing: Height : 279.4mm Width : 215.9mm orientation t_.-._ T
Select the Borderless Printing check
box to print images with no margins. [ save Settings

With the tiled photo printing, the types of paper that can be selected are limited to
those shown below:

AS
Ad
BS
Legal

#10 Env.

DL Env.

Canon 101.6 x 152.4 mm
Customl

Custom2

Custom3
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Click the OK button to close the Page S
A message box pops up, displaying the

etup dialog box.
information about printing.

You selected Borderless Printing.

The document to be printed is enlarged so that
it slightly extends off the paper. Print quality at
the top and bottom of the sheet may
deteriorate a little depending on the type of the
media used.

T

Read the message and click the OK button.
You will be returned to the Layout Options window.

Layout Options

The size of paper you specified in the
Page Setup dialog box is displayed.

Check the Automatic Clipping check box
to automatically crop images so that they
fit the paper you specified.

{—— Paper size :

———~—— |4 Automatic Clipping:

— Preview

Confirm the page setup and select the
number of images per page.

Vertical279.4 X Horizon1al215.9mm

Page setup...

No. of images

haxn =]

Set Photo Area..

[ Display this dialog when the Print window displays

Cancel || <Back || oK

Tiled Photo Printing (Borderless Printing)
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7/ Specify the number of photos.

Select the number of photos printed on one page from the No. of images pulldown
menu. The Preview area on the right side of the window shows how the selected
photos are arranged under the current settings.

*For example, select 1(1x1) to print only one photo on a page.

« 1{1x1)
2{1x2)
202x1)
F(1x3)
3(3x1)
4{2x2)
6{2x3)
6{3x2)

The figure below illustrates how the photos are placed on A4 paper depending on
the value of the No. of images pulldown menu.
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Specify paper margins (the space around the printed matter on a page) if
necessary.

Click the Set Photo Area button to open the Set Photo = selhotolireq
Area dialog box. In this dialog box, you can specify the top, 195: [0 Joom
bottom, right, and left margins. However, since the margins _ Mininurco.
will be automatically calculated and set to appropriate Lete - -~
values by the printer driver, in most cases you do not have to ltlmm Dmm
specify manually. You should specify the margins only when Mo | Mineuano
desired outputs are not produced.
Click the OK button to make the settings take ”Dmm
effect. " i page

[ vertically B

[ Horizontally D:l E [D

Click the OK button to exit the layout selection wizard.

The Print window appears where the selected photo images are arranged so that
they fit the page size you specified.

Page Artwork

When the Tiled photo printing option is selected, you cannot change the location
and size of the images although the image cropping and text insertion features are
available.

Starting Printing
Click the PRINT button to begin printing.
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Canon Perforated Paper Printing

The Canon perforated paper printing feature allows you to quickly print images on Canon perforated
paper.

Refer to About Canon Perforated Paper for more information on the types of Canon perforated
paper.

Note >» some printer models may not support the printing on Canon perforated paper. See
your printer manuals for more information.

Canon Perforated Paper Printing 95



Follow the steps below when performing the Canon perforated paper printing.

Steps

In the Browser area, select the image(s) to print with the Canon perforated paper
printing option. Then select Layout printing from the submenu that appears when
clicking the print button.

Lay out "
Inde:: printing...

The Layout Options window appears and the layout selection wizard starts.
Select the Canon perforated paper printing option in the Layout Options

window.

ayout Options

How would you like to print your photos?
) Custom layout printing
QO Index primting
(J Fixed photo size printing
Qi Tiled phote printing
@ Canon perforated paper printing

Prints images on Canon Perforated
Paper. The target printer may not
support some paper sizes. Please check
the paper packaging to confirm its
compatibility with your printer.

[A Display this dialog when the Print window displays

Canon Perforated Paper Printing
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Click the Next button to proceed to the next page.

Specify the type of Canon perforated paper.

When you select the type of Canon perforated paper, the Preview area on the right
side of the window shows how the photos are arranged under the current settings.

Layout Options

— Preview

Select the perforated paper type.

@ PHOTO PAPER PRO 4"x6™

(3 GLOSSY PHOTO CARDS 4"x6"

4[]

[ Display this dialog when the Print window displays

[ cancel  |[ <Back || 0K ]

The figure below illustrates how the photos are placed depending on the selected
type of Canon perforated paper.
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Click the OK button.

A message dialog box appears, indicating the size of Canon perforated paper you
just selected in the Layout Options window.

This paper size must be registered in the Page Setup dialog box that appears in the
next step.

s To print on this size of paper, you must set the following item in the
Page Setup dialog.

| The size of Canon perforated paper you
selected in the Layout Options window.

- Add the following paper size and then select it.
PHOTO PAPER PRO 4"x6" : {H}215.9 mm x {W)}118.6 mm

T

- Set the scale to [100%], and select vertical as the orientaion.

Click the [0K] button to open the Page Setup dialog.

[

The figure above shows the size of Photo Paper PRO <PC-101S>.

Click the OK button on the message box.

The Page Setup dialog box for the printer selected in the Chooser appears.
Select the Custom1 option from the Paper Size pulldown menu.

The Custom button becomes active.

Camon§330 version 4.0
0K
Paper Size : | Letter ¥
—
[ Banner Printing
o (4 Borderless Printing
i’:&i Amount of Extension :
Min, e Max.
Scale : @ %o
Height : 2794 Width :215.9 =
- m ! m Orientation : f
[ Save Settings

Canon Perforated Paper Printing 98



Note >» Be sure to unselect the Borderless Printing check box when performing the
Canon perforated paper printing. When this check box is selected, the Custom1
option in the Paper Size pulldown menu is disabled.

Click the Custom button.
A dialog box for paper registration appears.
Enter the size of the custom paper by following the message.

Canon 5330 Yersion 4.0

Media: |Cust0ml |

Unit: @ mm ) inch

PaperSize Margin

Height: | 215.9 Left: 3.2 Top: 2.8
Width: Right: 39  Bottom: 53

[ Cancel ] H Apply ]|

7

Once you have registered a custom paper, you do
not need to set up the same paper again.

s To print on this size of paper, you must set the following item in the
Page Setup dialog.

- Add the following paper siz€ and then select it.
PHOTO PAPER PRO 47x6" : {(H}215.9 mm x {W)118.6 mm

- Set the scale to [100%], and select vertical as the orientaion.

Click the [0K] button to open the Page Setup dialog.

=

Canon Perforated Paper Printing
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Click the Apply button.
The custom paper has been registered, and the layout selection wizard terminates.

Canonsiso Version 4.0

Paper Size ; | Letter > I

]

0K

-
[ Banner Printing
e, [ Borderless Printing
%’:&; Amount of Bxtension :
Min, e Max.
Scale: @ o

Height:279.4mm  Width:215.9mm

Orientation :

W (]

[ Save Settings

The Print window appears where the selected photos are arranged so that they fit
the paper size you specified.

Page Artwork

When the Canon perforated paper printing option is selected, you cannot
change the location and size of the images although the image cropping and text
insertion features are available.
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Starting Printing

1 Click the PRINT button to start printing.

O=—————rrint

The perforated line is displayed.

5 5 [BE | B <€

LAvOuT
RE-LAYOUT  ROTATE IMAGES FRINT
w  PERFPAGE OFTIONS
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This section briefly describes the Canon perforated paper.

The photos printed on Canon perforated paper can easily be cut apart by along the perforated lines.
This relatively thick, high glossy paper lets you print photo-quality images without blank portions
around them.

Types of Canon perforated paper are:

¢ Glossy Photo Card <FM-101>
Paper size:
Height 213.9 mm x Width 118.6 mm

¢ Photo Paper Pro <PC-101S>
Paper size:
Height 215.9 mm x Width 118.6 mm

About Canon Perforated Paper 102



Once you have completed all necessary steps for the page layout, follow the steps below to start

printing.
Steps

Click the PRINT button.

The Print dialog box of the printer selected in the Chooser appears.

Version 4.0

([Cprine_]
Copies :
]
10ns...
Srrom [ 10 [ ] [
ADDIY...
b1 Cartridge :
[Colour =)
Media Type :
[Prain Paper B3]
Paper Source :
[Auto Feeder B3]
Letter -
- Borderless Printing Print Mode :
[Text 2] [ Dpetails..

[ Greyscale Printing

Starting Printing
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Select the type of paper used for printing.

Select the type of paper you specified in the Page Setup dialog box from the Media

Type pulldown menu.

For example, select Photo Paper Pro when printing on the Pro Photo Card, and

select Glossy Photo Paper when printing on the Photo Glossy Card.

Yersion 4.0 -

Copies: D

Pages: @ All

& From l:l

:

BJ Cartridge :

_‘
B

b-d (=]

= 1%

E =

T =

[Culuur

Media Type :

+ Plain Paper

Photo Paper Pro

28 Borderless Printing

T=Shirt Transfer
Transparency

E Li]

Matte Photo Paper

Glossy Photo Paper
[ ] Letter High Resolution Paper
High Gloss Photo Film

Starting Printing
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Specify a print mode.
Normally, you should choose the Photo option when printing photos.
If you click the Manual button, the Details button becomes active as shown below:

VYersion 4.0 .
Copies:
]
Pages: @ All
Qrom [ [ Copionse]
BJ Cartridge :
[ Colour 3]
Media Type :
[ Plain Paper 2]
Paper Source :
Lett [Autu Feeder |i|
etter -
- Borderless Printing Print Mode :
[Manual [ 2| [ petails.. |
[ Greyscale Printing

-

Canon Detailed Setting

[ simulate illustration

Contrast : ———

[ Monochrome effects

@ Sepia {2 Blue
O Pink O Green
(21 Select colour

Colour : e

Calour

[ vivid Photo

[1 Photo Optimizer PRO
[ ] Apply Throughout Page

|=|| | Restore Defaults I -

Click the Details button to display the Detailed Setting dialog box. In this dialog
box, click the Special Effects button on the left side to activate photo color
correction features such as Vivid Photo and Photo Optimizer PRO.

Starting Printing 105



Vivid Photo

If the Vivid Photo check box is selected, green and blue are printed more vividly
while the color of skin tones remains intact. This feature is useful when printing
photos containing grass, sky, or sea in the background.

Photo Optimizer PRO

If the Photo Optimizer PRO check box is selected, the color data captured by a
digital camera is corrected based on the colors and tones. This may be useful when
correcting unnatural tones caused by fluorescent lights or incandescent lamps, or
overexposure or underexposure. This Auto Photo Perfect feature automatically
adjusts the brightness, preventing extremely dark areas in an image from turning to
shadows.

Click the Print button.
Printing starts.

Starting Printing
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Index Printing

ImageBrowser’s index printing feature allows you to quickly print an index (a list of thumbnails) of
the selected images. You can specify the size of the thumbnails.

All of the selected images are automatically
arranged and then printed.

Index printing

Paper size :
WVerticalz97.0 X Horizontal209.9mm

Thumbnail size
() Large
@ Middle
3 Small

No. of images: 18

No. of pages: 2

Cancel II Start printing I
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Use this printing method to quickly print the index of the selected images (thumbnails) without

opening the Print window.

Steps

In the Browser area, select the image(s) to print with the index printing technique.
Then select Index printing from the submenu that appears when clicking the

PRINT button.

The Index printing window appears.

Index printing

Paper size :
Vertical297.0 X HorizontalZ09.9mm

Thumbnail size

) Large
@ Middle

(2 Small

Mo. of images: 18

Mo. of pages: 2

[ Cancel ]” Start printing ]l

Click the Page setup button.

Inde: printing...
Select the size of thumbnails. The number of
pages used for printing depends on the number
of selected images and the size of thumbnails
specified in the Index printing window.

The Page Setup dialog box for the printer selected in the Chooser appears. Specify

the paper size and orientation.
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Click the OK button to close the Page Setup dialog box.

Canon 5330

version 4.0

Height :279.4mm  ¥idth :215.9mm

0K

J

Paper Size : | Letter *
[ Banner Printing
B4 Borderless Printing
Amount of Extension :

Min. e Max.

scale: [50|#)%

[ Save Settings

Specify the size of thumbnails.

The number of pages used for printing depends on the number of selected images,
the size of thumbnails specified in the Index printing window, and the size of paper

specified in the Page Setup dialog box.
Click the Start printing button.
The Print dialog box appears.

Click the Print button in the Print dialog box.

Printing starts.

Index Printing
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Previewing the Page Layout before Printing

You can preview the page layout before printing an index of the selected images.

Steps

7 Inthe Browser area, select the image(s) to print with the index printing. Then select
the Layout printing from the submenu that appears when clicking the PRINT
button.

Index printing...

The Layout Options window appears and the layout selection wizard starts.
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Select the Index printing option.

ayout Option:

How would you like to print your photos?
(3 Custom layout printing
@ Index printing
() Fixed photo size printing
(2 Tiled photo printing
(3 Canon perforated paper printing

Print the list of images.

[ Display this dialog when the Print window displays

@]

Click the Next button to proceed to the next page.

— Preview

Confirm the page setup and select a
thumbnail size.

Paper size @
Vertical297.0 X Horizontal209.9mm

Thumbnail size
@ Large
(O Middle
(Jr Small

[ Display this dialog when the Print window displays

[ cancet ][ <Bae || oK ]
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Click the Page setup button.

The Page Setup dialog box for the printer selected in the Chooser appears. Specify
the paper size and orientation.

Canon §330 Version 4.0
0K I
Paper Size : | Letter =
[ Banner Printing
[ Borderless Printing
Amount of Extension :
Mifl, et Max.

Height:279.4mm  Width:215.9mm

[0 save Settings

Click the OK button to close the Page Setup dialog box and return to the Layout
Options window.

Layout Options

— Preview

Confitm the page setup and select a
thumbnail size.

The size of paper you specified in the _
Page Setup dialog box is displayed. [ erteatzr.4 % Horiontat215.9mm

Thumbnail size

® Large
O Middle
@ small

[ Display this dialog when the Print window displays

cancel |[  <Back || 0K |

[5]
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Specify the size of thumbnails.
You can select from the Large, Medium, and Small options.

The Preview area on the right side of the window shows how the thumbnails are
arranged under the current settings.

N R
DDDD e |
S |
EEE= OoEEED
Large CIEEE medium EEEEEE| Small

Click the OK button to exit the layout selection wizard.

The Print window appears, showing the thumbnails that are arranged according to
the current settings.

Click the PRINT button.
The Print dialog box for the printer selected in the Chooser appears.

Yersion 4.0

Copies : -
-
Pages: @ All —
Q@ From I:l To l:l _
BJ Cartridge : Apply...
[Cnlnur ﬂ
Media Type :
[Plain Paper ﬂ
Paper Source :
[Autu Feeder i.l
Letter - -
“ Borderless Printing Print Mode :
[Text 2] [ petails...
[ Greyscale Printing
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Specify the Media Type and the Print Mode.

Select the type of paper you specified in the Page Setup dialog box from the Media
Type pulldown menu.

When printing photos, usually select the Photo option for the Print Mode. Select
the Text option for the Print Mode to reduce printing time, if necessary.

Click the Print button to start printing.
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Page Artwork

* Editing the Layout Format
* Inserting Text
* Cropping an Image
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Editing the Layout Format

When you select the Custom layout printing option in the Layout Options dialog box, you can
move, reduce and delete the images in the Print window.

O=———mm=——————=HH

o B

RE-LAYOUT ~ ROTATE IMAGES
¥  PERPAGE

LavouT
OFTIONS ERA

Print —ce00——n—p15

= B [

(# e

RE-LAYOUT  ROTATE IMAGES:
¥ PERPAGE

<
LAYOUT
OFTIONS EEN

Editing the Layout Format
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In the Print window, you can move an image to a different location.

When you select the Custom layout printing option in the Layout Options dialog box, you can
move an image by dragging it in the Print window.

Select the image you want to move in the Print window.
A blue frame appears around the image.

————pinl—"——"o08

:
= B E
= [

RE-LAYOUT ROTATE IMAGES

s PER PAGE

<

Lavour
opTions  omMT
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Drag the image to move to a different location.

—————————— it

2l =]

= B 4

RE-LAYOUT  ROTATE IMAGES:
¥ PERPAGE

9

LAYOUT e

OFTIONS

The image that was moved.

Note >» Wwhen you select one of the options other than the Custom layout printing, you
cannot move images in the Print window. However, the display order can be
changed by dragging one of the images.

Editing the Layout Format
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Changing the Size of an Image

When you selected the Custom layout printing option in the Layout Options dialog box, you can
enlarge or reduce the selected image by dragging its frame (blue line). When the mouse cursor is
positioned over the image frame, the cursor changes into I . Then drag the mouse to enlarge or
reduce the image.

Steps

1 Select the image you want to change its size.
The frame appears around the image.
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" Move the cursor over the frame of the image, and drag the mouse to enlarge or
reduce it.

When the mouse cursor is positioned over the image frame, the cursor changes
into .

Note » when you select one of the options other than the Custom layout printing, you
cannot enlarge or reduce images in the Print window.
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You can rotate the selected image by selecting the 90 degrees right, 90 degrees left, or 180
degrees option from the submenu that appears when clicking the ROTATE button.

Select the image you want to rotate.

The frame appears around the image.

O=———rrint

=i =|

AL

S B COE | H 9

LAYOUT
RE-LAYOUT  ROTATE IMAGES FRINT
L RS OPTIONS
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Click the ROTATE button to display a submenu, and select one of three options, 90
degrees right, 90 degrees left, and 180 degrees, as needed.

20 degrees right
0 degrees left
120 degrees

According to the option you selected, the image is rotated.

0 —==—r———=min———=FHH

DT

v

=B [

RE-LATOUT ~ ROTATE IMAGES
¥ FERFAGE

D

Lavour
OFTIoNs R

Note » when you select one of the options other than the Custom layout printing, only

the 180 degrees option is available. When the current layout is the Index printing,
all image rotation features in the Print window are disabled.
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Deleting an Image

You can delete a selected image in the Print window. However, note that the deleted image is only
excluded from printing, and the original image file remains intact.

1 Select the image you want to delete.
The frame appears around the image.

Selected image

~ Press the Delete key on the keyboard.
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The selected image is cleared.

The image disappears.

You can also delete the selected image by selecting
Clear from the Edit menu.
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You can enter text anywhere in the page displayed in the Print window.

The text entered in the Add Text window is displayed in the center of the Print window within the
frame (blue outline rectangle), indicating the text is selected. The selected text can be moved by
dragging with the mouse.

Double-clicking the selected text displays the Edit Text window, in which you can edit the text.
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Steps

Select Add Text from the Edit menu.
The Add Text window appears.
Specify text’s justification.
Select the font size.

|
%E Add Text g =]

Select the font. [Helvetica BN ' =] EEED
Specify the font style. Available styles and effects are (B][/][u] = ][e] 3] ][]

(from left to right):
bold, italic, underlined, outline, shadow, wide space,
narrow space, and color.

ST

[4]¥

Enter text.
You can specify the text attributes such as the font, font style, color, and alignment.

=  AddTen———H
[HElVEtiEﬂ i] [ 4 ij
[B][ /| u][s][s ]3|~ m

MY
FAVORITE Print window i e form t 3ppears

the Add Text window.

S

[«

Inserting Text 126



3 Click the OK button.
The entered text is displayed in the Print window within the frame (blue). The text
can be moved by dragging with the mouse.

[ —0—=—x=rrim

ool 370
il L E@
RE-LAYOUT  ROTATE IMAGES
¥ PERFAGE

OPTIONS o
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You can add a caption to each of the images in the Print window.

If the current layout is the Custom layout printing or the Index printing, the entered caption
appears immediately below the selected image.

When the current layout option is neither the Custom layout printing nor the Index printing, the
entered caption is displayed in the location specified in the Edit Caption window (the alignment
setting for text). Double-clicking the entered caption in the Print window displays the Edit Caption
window, in which you can edit the string.

Note >» The steps for adding a caption to the image are the same as those for entering text

into the page except for the window invoked by the command and the location
where the text is displayed.
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You can add a header to the page. The header is displayed at the top of the printable area of the
page.

In the Print window, the entered header is inserted at the horizontal position specified in the Edit
Header window (the justification setting for text, that is, left, center or right).

Double-clicking the entered header in the Print window displays the Edit Header window, in which
you can edit the string.

Note >» The steps for adding a header to the page are the same as those for entering text

into the page except for the window invoked by the command and the location
where the text is displayed.
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Cropping an Image

An image in the Print window can be cropped. This image cropping feature gives you the ability to
specify the area for printing without changing the original image data.

Steps
1 Select the image you want to crop, and select Clipping from the Edit menu.
The Clipping window appears.

Double-clicking the image also displays
the Clipping window.

2 =]

0]

KD

REDUCE button / ©F CX
Reduces the size of the REDUCE ENL ARGE

image up to 25% of the Image Size:  768x512 > | ( |isplay:  25% ez
original size. Q —
T.h @ size of the image is The size of the image is displayed. The current display
displayed.

percentage appears.

ENLAEGE button
Enlarges the size of the image.
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2 Drag the mouse over the image to select the area to be cropped.
Click outside the selected area to deselect it.

— Selected area for cropping

xxxxxx

3 Click the close box at the upper left corner of the Clipping window.

The Clipping window is closed and the cropped image is displayed in the Print
window.
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Limitations of the image cropping feature depending on the current layout

When the current layout is the Custom layout printing, you can select a clipping area of any size
and any height/width ratio.

However, in case the current layout is the Tiled photo printing, Fixed photo size printing, or

Canon perforated paper printing, cropping is restricted to the vertical clipping or horizontal
clipping. This is because the height/width ratio is fixed in these three layout modes.

@ a  Q

.....

HORIZOMT AL

CLIPR ING REDGLICE ENL ARGE
Irmage Size: TEExE12 | [visplay: 100% i
Select this button to crop Select this button to crop
the image in a portrait ~—— — the image in a landscape
format. format.

Note that the Index printing layout option does not support the cropping feature.

Cropping an Image
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ImageBrowser provides you Online Help with information about functions and operations. It
contains a brief description of operational steps that you can read on the screen while operating the
program.

E gr&qug

[rmageBrowser Introduction
Connecting to Canon Digital Camera

Downloading from Canon Digital Camera

Uploading to Canon Digital Camera

Editing a Canaon Digital Camera S1ide Show/DPOF
Frocess Canon Digital Camera Images Automatically
Printing on Canon Perforated Paper

FPrinting Freely Sized and Positioned lmages

1

[mageBrowser is an image file management program with the following
features.

T

1. Features for Connecting to Canon Digital Cameras
- Displays images from a compatible camerals CF card.
- Downloads images from the camers to the computer.
- Uploads images from the computer to the camera.
- Edits glide shows for replay by the camera.
- Allows you to set how images print in accord with DPOF standards.
[4]»

S
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Index

A
Add Text window 81
adding a caption to the image 128
adding a header to the page 129
adding sound to an image 37
Adjusting colors of an image 28
adjusting colors of an image 28
audio data 37
Auto Launch control panel 67
Automatic Clipping check box 87, 92
Automation wizard 8, 13, 49, 52, 55, 66
Automation wizard dialog box 51

B
Borderless Printing 91
Browser area 19, 25, 40, 46, 89, 110

C
Camera Window 55, 58
Canon Utilities 12
changing display options 21
changing the location of images 22
changing the size of an image 119
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Chooser 86, 91, 103, 112, 113
Clipping window 77, 130
Communication Settings 66
CONNECT CAMERA button 59
connection between the device and the computer 59
Control panel 17
Control Panels 67
Create Image for Email dialog box 54
creating image files attached to E-mail 40
creating panoramic photos in PhotoStitch 44
cropping an image 77, 130
Custom layout printing 10, 61, 71, 75
custom paper 99, 100
D
DCIM 55
delete an image 76
DELETE button 60
delete the image from the device 60
deleting an image 24, 123
digital camera 7,13, 17, 59, 66
display mode 36
DOWNLOAD button 60
downloading 60
E
Edit Caption window 128
Edit Header window 129
Edit menu 124
editing the layout format 116
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effects for slide show

enlarging and reducing an image
entering text into the page
Explorer View

export

Fixed photo size printing

image cropping

IMAGE INFO button

image size

Importing Images

importing images

importing images using the Camera Window
index (list) format

Index printing

information about printing

inserting text

justification setting for text

layout

layout option

Layout Options dialog box
Layout Options window
Layout printing

Index

31
80
125
17, 19, 36, 56
63

5, 85

94, 100, 130, 132
64

10, 63

48

13, 48, 52

55

9

4, 61, 84, 108, 111
92

10, 125

129

84, 89, 96

9, 128

116, 117, 119

84, 85, 89, 90, 92, 96, 98, 110, 112
70
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layout selection wizard 70, 71, 88, 89, 96, 100
M
Media Type 114
memory card 8, 55, 58
moving an image 79, 117
o)
Online Help 133
Opening the image 46
opening the image 46
P
page artwork 75
page layout 110
Page Setup dialog box 72, 86, 91, 92, 104, 109, 112
paper size 86, 112
Paper Size pulldown menu 98
perforated line 101
perforated paper 9, 95, 97, 102
perforated paper printing 6
Photo Optimizer PRO 106
Photo Size 87
PhotoStitch 44
playing mode and options for slide show 31
Preference window 46
Preview area 97
preview display 20
previewing the page layout 110
PRINT button 61
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Index

Print dialog box 103, 113
Print Mode 114
Print window 73, 128
printing 61, 69, 103
resizing 63
ROTATE button 62
rotating an image 121
rotation 62
saving a modified image 29
scanner 7
SELECT button 59
Set Photo Area dialog box 94
Settings for USB connection 67
SETUP OPTIONS button 59
slide show 30
Slide show navigation buttons 34
SLIDE/DPOF button 65
Sound control panel 37
Sound menu 39
Sound Panel 39
text insertion 94, 100
thumbnail area 63
Thumbnails 17
thumbnails 4, 44, 58, 109, 113
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Index

tiled photo 89, 91

Tiled photo printing 5, 89, 90, 94

Time Tunnel 36

trimming 4,10
U

updating the information 25

upload an image 63

UPLOAD button 63
\'}

View menu 36, 39

View Mode 20, 36

View Settings 21

Vivid Photo 106
w

wizard 9
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